
 The New Grolier Multimedia Encyclopedia Help Contents
The following Help Topics are available:

How To...
Register the NGME and get Technical Support 
Look up something 
Use the Features Menu 
Listen to a sound 
Play an animation 
Play a Multimedia Map 
Play the Knowledge Explorer 
Use the Knowledge Tree 
Use the Timeline 

 View a picture 
Watch a video 

Commands
File 
Edit 
Search
Text
Window
Bookmark
Help

Toolbars 
Main Toolbar buttons and their functions
Other Toolbar buttons and their functions 

For Help on Help, Press F1



Main Toolbar buttons and their functions
These buttons appear on the Main Toolbar of the NGME:

      Browse Titles   

      Word Index  

      Word Search  

      Knowledge Tree   

      Timeline   

      Sound Index   

      Map Index   

      Multimedia Map Index   

      Picture Index   

      Video Index   

      Animation Index   

      Knowledge Explorer   

      Link to Selection   

      Next Link   

      Search for Selection   

      Add a Bookmark   

      Print   

      Save   

      Help   



Other Toolbar buttons and their functions
These buttons appear on various toolbars throughout the NGME:

Navigation buttons

      Move a level deeper in an index  

      Move a level higher in an index  

Audiovisual controls

      Play a multimedia feature  

      Stop playing a sound/video/animation  

      Pause a video/animation   

Linking buttons

      Link to a map   

      Link to a picture   

      Link to a video   

      Link to an animation   

      Link to a sound   

      Timeline Find  

      See cross-reference list   

Article view option buttons

      View table   

      View outline   

      View factbox   

      View caption   

      Move to the previous hit word   

      Move to the next hit word   



 Move a level deeper

This moves you a level deeper in an index, e.g., from topic to subtopic in the Knowledge Tree.

See also:
Other Toolbar buttons and their functions 



 Move to the previous hit word

This allows you to travel from your present location within an article to the previous occurrence of 
your Search Word(s).

See also:
Other Toolbar buttons and their functions 



 Move to the next hit word

This allows you to travel from your present location within an article to the next occurrence of your 
Search Word(s).

See also:
Other Toolbar buttons and their functions 



 Move a level higher

This moves you back up a level in an index, e.g., from subtopic to topic in the Knowledge Tree.

See also:
Other Toolbar buttons and their functions 



 Pause an animation

Click this button to temporarily stop animation playback. Click play to resume.

See also:
Other Toolbar buttons and their functions 



 See cross-reference list

Use this toolbar button to generate a list of articles cross-referenced from the current article or 
feature. Scroll the list of cross-referenced articles to find the desired title.

Double-click an article title to view the article. You may scroll through the article or, if you have 
accessed it through Word Search or Word Index, you may click the next hit word /previous hit word 
button to see the next/previous occurrence of your Search Word(s) in the article.

See also:
Other Toolbar buttons and their functions 



 Play

Click the play button to play a video, animation, Multimedia Map, Knowledge Explorer essay, or sound
clip.

See also:
Other Toolbar buttons and their functions 



 Stop

Click the stop button to stop a video, animation, Multimedia Map, Knowledge Explorer essay, or 
sound clip.

See also:
Other Toolbar buttons and their functions 



 Link to a Map

Click the map button (if present) in the current article's toolbar to list the map(s) illustrating it.
Double-click a map title to view a map.

See also:
Other Toolbar buttons and their functions 



 Link to a Picture

Click the picture button (if present) in the current article's toolbar to list the picture(s) illustrating it. (If 
there's only one picture, it will be displayed.) Double-click a picture title to view a picture. Click the 
caption button to read a picture's caption.

Some picture displays show a sound button. Click it to access the audio controls for the sound 
associated with a picture. Press the play button to play, press the stop button to stop.

See also:
Other Toolbar buttons and their functions 



 Link to an Animation

Click the animation button (if present) in the current article's toolbar to list the animation(s) illustrating 
it. Double-click an animation title to select that animation. Click the play button to play, click the stop 
button to stop.

See also:
Other Toolbar buttons and their functions 





 Link to a Video

Click the video button (if present) in the current article's toolbar to list the video(s) illustrating it. 
Double-click a video title to select that video. Click the play button to play it, click the stop button to 
stop it.

See also:
Other Toolbar buttons and their functions 



 Link to a Sound

Click the sound button (if present) in the current article's toolbar to list the sound(s) associated with it. 
Double-click a sound title to select that sound. Click the play button to play it, click the stop button to 
stop it.

See also:
Other Toolbar buttons and their functions 



 View Table

Many articles in the NGME list additional information in tabular form.

When you're looking at an article, this button will appear on the article's toolbar if one or more tables 
are associated with the article. Click it to list the table(s) associated with the article. Double-click a 
table's title to view it.

When viewing the table, use the scroll bars to move through it.

See also:
Other Toolbar buttons and their functions 



 View Outline

Many of the longer articles in the NGME have outlines which make it easier to find the information you
desire. Click the Outline button (if present) from an open article to access its outline. Double-click the 
desired topic to move to that point in the article.

See also:
Other Toolbar buttons and their functions 



 View Caption

Use this toolbar button when you're looking at a picture or a video to see the caption that describes it.

See also:
Other Toolbar buttons and their functions 



 View Factbox

Factboxes list important, frequently cited statistics. They are found in the NGME's articles on 
continents, countries, U.S. presidents, U.S. states, and Canadian provinces.

When you're looking at an article, this button will be present in the article's toolbar if the article 
contains a Factbox. Click it to move to the article's Factbox.

When viewing the Factbox, use the scroll bars to move through it.

See also:
Other Toolbar buttons and their functions 



File Menu
The following commands are available from the File menu:

Save 
Close 
Print 
Preferences 
Exit 



Edit Menu
The following commands are available from the Edit menu:

Copy 
Paste 



Search Menu
The following commands are available from the Search menu:

Browse Titles 
Word Search
Word Index 
Knowledge Tree 
Timeline 
Pictures 
Maps 
Multimedia Maps 
Animations 
Sounds 
Videos 
Knowledge Explorer 
Find 
Search for Selection 
Link to Selection 
Next Link 



Text Menu
The following command is available from the Text menu:

Font 



Window Menu
The following commands are available from the Window menu:

Toolbar 
Status 
Cascade 
Tile 
Arrange Icons 
Close All 



Bookmark Menu
The following commands are available from the Bookmark menu:

Bookmark List 
Add 
Delete 



Help Menu
The following commands are available from the Help menu:

Contents 
Contributors 
About 



Save (File menu)

You may save NGME text in ASCII format to use in a word-processing program, or you may save it in 
a print-to-disk format. The dialog box allows you to save the complete article (default), a highlighted 
selection, or a window of text.

Shortcut:  on the Main Toolbar 



Close (File menu)

Use this to close the currently active window.



Printer Setup

Use this to configure Windows and the way it deals with your printer. The dialog box allows you to 
specify which printer to use, printing orientation (portrait/landscape), and paper size.



Print (File menu)

Use this to print the currently selected text, picture, or map. The dialog box allows you to select a 
complete article, a highlighted portion, or a range of pages. It also allows you to specify print quality 
and to print to a file. 

Note: some of the pictures are not printable due to copyright restrictions.

To configure your printer use the Printer Setup option.

Shortcut:  on the Main Toolbar 



Preferences (File menu)

Select Preferences to customize the NGME by changing its default settings. You can change the 
following settings from this window:

Default search settings
Use this to specify whether the results of a search are to be sorted alphabetically (by article title), or 
by the frequency of occurrence of the Search Word(s) (e.g., an article with 10 occurrences of a 
Search Word is listed before an article with only 3 occurrences).

You can also change the "number of words apart" criterion in a search with multiple Search Words; 
see Search Options    for more information.

Display Registration Message
The NGME will display a notice asking you to register. Once you have registered the NGME you can 
stop this message from displaying by removing the "X" from this option.

Display features menu and graphical indexes
If you don't want the Features Menu and the graphical indexes to be displayed, remove the "X" from 
this option. Once this is done, you will see text instead of pictures in the indexes.
 
Display title animation at startup
If you don't want to see the startup sequence (the Grolier logo and the collection of pictures), remove 
the "X" from this option.

Display Status Bar at startup
If you want the status bar to be active when you start the NGME, mark this checkbox. See also: 
Status (Window Menu).

Display Toolbar at startup
This lets you customize the appearance of the Main Toolbar when you start the NGME. For more 
information, see Toolbar (Window Menu).

Display Videos and Knowledge Explorer in full screen mode
You may display the videos and Knowledge Explorer essays in full screen mode by adding the "X" to 
this option.



Exit (File menu)

Use this command to end your NGME session.



Undo (Edit menu)

Use this to Undo your previous action.



Copy (Edit menu)

Use this to copy the currently selected text from a window. You may use this text in other Windows 
applications (e.g., word processing programs).



Paste (Edit menu)

Use this to paste text (from your most recent Copy) to the cursor location in the current window.



Browse Titles (Search menu)

This gives you an Article Index containing an alphabetical list of the 33,000+ articles in the NGME.

Finding an Article
Type the article title, or the first few letters of a subject, and select Find to move the cursor to that 
point in the Article Index. Select your desired topic. Double-click to open the article.

Shortcut:  on the Main Toolbar 



Word Search (Search menu)

Word Search lets you search for occurrences of a word or set of words in the NGME.

Simple Word Search
The simplest way to use Word Search is to type in a single word. (Note: certain words, such as "and,"
are excluded from this feature because they occur too frequently in the NGME to provide meaningful 
Word Search results.)    Click the Search button and the NGME will look for the word you've typed. 
The NGME will list all of the articles that contain that word.

Double-click an article title to see the article; the cursor will be at the first occurrence of your Search 
Word. Click the forward/backward buttons to see subsequent/previous occurrences of the word.

Complex Word Search
You can do more sophisticated word searches by using the tools and options provided in the Word 
Search dialog box. These help you to limit or expand your search.

Operators and Wild Cards 
These let you look for variations and combinations of words in a search.

Search options 
These are tools provided by Word Search that let you specify where and how to look for a
word or group of words.

Other Word Search controls
There are two other special controls in the Word Search dialog box:

Paste
This button lets you paste the contents of the Windows clipboard into the current Search 
Word field. This is especially useful if you've copied a word from another article, or from 
another Windows application (such as a word processor).

Reset 
This button resets the search, erasing all Search Words and resetting any operators or 
other options you may have changed.

Shortcut:  on the Main Toolbar 



Word Index (Search menu)

The Word Index lists, in alphabetical order, each word that appears in the NGME.

Click the Word Index button on the Main Toolbar, or select Word Index from the Search menu, to open
the Word Index. As you begin to type, a Find box will appear. Click Find after you type in a word. The 
cursor will move to that word in the Word Index. Double-click to see a list of articles containing the 
word, sorted by number of occurrences.

Shortcut:  on the Main Toolbar 



Knowledge Tree (Search menu)

Knowledge Tree lets you explore the NGME by subject, gradually refining your search from a broad 
topic to subtopics to individual articles on your subject.

Using Knowledge Tree
A plus sign next to a topic name indicates that a topic must be explored further to reach individual 
articles (e.g., + The Arts).

A minus sign next to a topic name indicates the path your search has taken.

Select and double-click a topic without a plus or minus sign to see a list of articles related to that 
subtopic.

Shortcut:  on the Main Toolbar 



Timeline (Search menu)

The Timeline is a chronological list of more than 5,000 historical events. It allows you to explore the 
NGME with time as a frame of reference.

Using the Timeline
Type a year and AD or BC (the default is AD) to look at events for a certain year. You may also scroll 
through the list. Double-click a Timeline event to see a list of articles related to the event.

You may search the Timeline for a specific event. Simply pull down the Search menu and click Find 
while you are in the Timeline. A Timeline Search window will open. Type in a range of dates and a 
Search word or Search words and click Find. The NGME will return a list of Timeline entries (within 
the range of dates you have specified) that contain the Search word you typed.

Searching the Timeline from within an article
To search theTimeline from within an article or caption, simply highlight a year and press the Timeline 
Find button on the article or caption's menu bar. The NGME will bring you to that year in the Timeline. 

Note: Because the Timeline is illustrative, not comprehensive, not every event, or even every year is 
necessarily listed. If you search for a year that isn't included in the Timeline, the NGME will bring you 
to the closest year available.

Shortcut:  on the Main Toolbar 



Find (Search menu)

Find allows you to look for the next occurrence of any word in an article or picture caption. After you 
select Find, type the word you want to locate in the Find dialog box and click Find. 



Next Link (Search menu)

Next Link helps you find the next Link Word (an article title set in ALL CAPS) within an article. 

From any word in an open article, select Next Link to move the cursor to the next cross-referenced 
article title. You can then use the Link to Selection command to search for that title in the Title List.

Shortcut:  on the Main Toolbar 



Link to Selection (Search menu)

Link to Selection allows you to search the Article Titles List for a Link Word (an article title set in ALL 
CAPS within an article).

Move the cursor to the first letter of a Link Word and select Link to Selection or simply double-click the
Link Word. The NGME will open the Title Index and move to the Link Word. Double-click the title (or 
press Enter) to look at that article.

Shortcut:  on the Main Toolbar 



Search for Selection (Search menu)

Search for Selection allows you to select (highlight) a word or string of words in an article and find 
other articles in which the words appear. For example, if you select the word "physics" in an article, 
the NGME will create a list of all articles in which "physics" appears.

Shortcut:  on the Main Toolbar 



Font (Text menu)

This feature allows you to customize the appearance of the text elements of the NGME. The Font 
dialog box allows you to specify base font, style, and size.



Toolbar (Window menu)

This feature allows you to customize the appearance of the Main Toolbar. You may choose one of the 
following:

Off
This conceals the Main Toolbar, giving you more space in the Main NGME window.

Top
This makes the Main Toolbar appear as a row of buttons beneath the Menu Bar.

Float
This turns the Main Toolbar into a movable window, which you can "float" among other windows you 
have opened in the NGME. Use Float to gain space in the Main NGME Window    without sacrificing 
the convenience of the Toolbar. (Note: Other Windows applications call this a "tool palette.")

See also:
Main Toolbar buttons and their functions 
Other Toolbar buttons and their functions 



Status (Window menu)

This feature allows you to toggle between displaying and concealing the Status bar, which provides 
information on the status of actions taken in the NGME. Concealing it gives you more space in the 
main NGME window.



Cascade (Window menu)

Cascade arranges opened windows on top of each other, like a set of index cards. It puts the most 
recently opened window on top, and displays each window's title, for easy movement between 
windows.



Tile (Window menu)

Tile arranges opened windows side by side, for easy comparison of contents.



Arrange Icons (Window menu)

Use this command to arrange icons representing minimized windows in an orderly fashion in the main
NGME window.



Close All (Window menu)

Use this command to close all of the currently open windows, without shutting down the NGME. 



Bookmark List (Bookmark menu)

Bookmark lets you create a list of NGME articles of interest for future reference.

To open a bookmarked article
Double-click the desired Bookmark name to access the bookmarked article.

To delete a Bookmark
Choose Delete from the Bookmark menu to delete the currently selected Bookmark.



Add a Bookmark (Bookmark menu)

Use this command to save your place in an NGME article. You can retrieve it later by using the 
Bookmark List command.

When you select Add a Bookmark, you'll see a box with a Bookmark Title. The default is the article's 
title, but you may type in a more descriptive name. Click OK to store the Bookmark.

Shortcut:  on the Main Toolbar 



Delete a Bookmark (Bookmark menu)

Use this command while looking at the Bookmark List to delete a Bookmark. When you choose it, the 
selected Bookmark is deleted.



Help Contents (Help menu)

Help Contents lists, in outline form, all of the Help topics available in the NGME.

For help on using Help, press the F1 key.

Shortcut:  on the Main Toolbar 



About (Help menu)

This gives details about the NGME such as the version number and copyright information.



Map Index (Search menu)

The Map Index lists all of the maps in the NGME, grouped by geographical location.

Viewing maps using the Map Index
Double-click the name of a region to list maps for that region. Double-click a map's title to view it. You 
may also access a list of articles cross-referenced from the current map by clicking the cross-
reference button in the Map Index window's toolbar.

Shortcut:  on the Main Toolbar 



Picture Index (Search menu)

The graphical Picture Index groups all of the pictures in the NGME into categories.

Viewing pictures using the Picture Index
Pictures are indexed in outline form. A plus sign (+) before a title indicates that you are at a topic 
within the Index, and that you must expand the index to reach picture titles. A minus sign (-) indicates 
your path so far. Picture titles are indicated by the absence of a plus or minus sign. (Some pictures 
are linked to sounds; this is indicated by an asterisk (*) after the picture title.)

You can look at a picture by double-clicking its title. You can look at a list of articles cross-referenced 
to the selected picture by clicking the cross-reference button in the Picture Index window's toolbar.

Each picture's window has its own toolbar, containing one or more of these buttons:

      View caption   

      See cross-reference list   

      Link to a sound   

Shortcut:  on the Main Toolbar 



Animation Index (Search menu)

The Animation Index lists all of the animations in the NGME, grouped by subject.

Viewing Animations using the Animation Index
Click the animation button to view the graphical index of animations. Select a category to list 
animation titles for that category.

(Animation titles have no preceding symbol; a plus sign indicates a category or sub-category of 
animations.)

Click the play button to play an animation. Click the stop button to stop it.

When an animation title is selected, click the cross-reference button on the Animation Index window's 
toolbar to view a list of articles related to that animation.

Shortcut:  on the Main Toolbar 



Video Index (Search menu)

All the videos in the NGME are grouped into categories in the graphical video index.

Using the Video Index
After choosing this option (either from the Search menu or through the Main Toolbar's Video Index 
button), you'll see the graphical index of videos. Select a category to list video titles in it.

Click the play button to view a video. Click the stop button to stop it.

When a video title is selected, click the cross-reference button on the Video Index window's toolbar to 
view a list of articles related to that video.

Shortcut:  on the Main Toolbar 



Sound Index (Search menu)

The Sound Index lists all of the sounds in the NGME, grouped by type.

Listening to sounds using the Sound Index
Select a category from the graphical index of sounds to list sound clip titles. Double-click the title of a 
sound clip to display the audio control panel. Click the play button to start a sound clip; click the stop 
button to stop it.

Click the cross-reference button to list the titles of articles related to the sound clip.

Shortcut:  on the Main Toolbar 



What's a Toolbar?
A toolbar is a set of buttons, usually located beneath the title bar of a window, which gives you quick 
access to frequently used commands in the NGME.

Using a Toolbar
Click a Toolbar button to call up the NGME feature it represents.



What's the NGME?
The NGME, which you are currently using, is the New Grolier Multimedia Encyclopedia. The NGME 
features the complete text of Grolier's Academic American Encyclopedia, plus multimedia features, 
the Knowledge Tree, and a Timeline.



What's a default?
In a computer program, a default is the way settings and options are defined by the program before a 
user changes them. In other words, a default is an action or setting done without user intervention, 
something done "by default."    Many programs, such as the NGME, allow you to change some default
values to suit your own needs and tastes.



What's a hit word?
A hit word reflects a match between a word you're searching for and a word in the NGME. It's often 
convenient, especially in a long article, to move forward and backward among hit words to find the 
information you're looking for.



What's ASCII?
ASCII (pronounced /as' kee/) is an acronym for American Standard Code for Information Interchange.
Many applications (including the NGME and most word processors) use this term to refer to raw, 
unformatted text. Documents "saved in ASCII" contain no special formatting commands or codes, and
therefore are easily recognized and used by a variety of applications.



Search Options (Word Search)

Word Search has a few options to let you specify where and how to look for occurrences of your 
search terms.

Word Relationship
Word Relationship lets you fine-tune your search by specifying certain criteria for a successful search.

Same Paragraph
When this is chosen, the search will require that all the terms you've specified be in the 
same paragraph. This criterion is chosen by default.

Words Apart
When chosen, this lets you specify how close multiple Search Terms must be to each 
other to show up in your Word Search.

Exact Order
Use this checkbox to find a precise phrase (i.e., search for words in the same order 
you've typed them).

Search in
This lets you fine-tune your search by specifying which parts of the NGME to search.



Operators and Wild Cards (Word Search option)

Word Search lets you use operators and wild cards to limit or broaden your search. The AND, OR, 
and NOT operators can be used to set up criteria among multiple Search Words. Wild cards are 
helpful in finding words related to your Search Word, or if you're not sure of the spelling of a particular
word.

AND
This lets you search for two or more words in a single article (each Search Word must appear in the 
article at least once).
How to do it: Type the words on separate lines and choose AND in the drop-down menu next to the 
words (this is chosen by default)

OR
This lets you search for two or more words in a single article (at least one Search Word must appear 
in the article).
How to do it: Type multiple words on one line, separated by commas.

NOT
This lets you search for the presence of a word or combination of words in the absence of another or 
others.
How to do it: Type the words on separate lines and choose NOT in the drop-down menu next to the 
word(s) you want exclude from the search.

Wild Card (single character)
This will find all instances where your Search Word(s) plus any single letter forms a word (e.g., 
QUOT? will match "quota" and "quote").
How to do it: Type a question mark ("?") at any location in the Search Word.

Wild Card (multiple characters)
This will find all instances where your Search Word(s) plus any number of letters forms a word (e.g., 
QUOT* will match "quota,"    "quotation," "quoted," "quotes," etc.).
How to do it: Type an asterisk ("*") at the end of your Search Word(s).



How to Look Up Something in the NGME

Here are three ways to Look Up Something in the NGME:

Pretty sure you know where your subject would be covered?
Click the Browse Titles button on the Main Toolbar or select Title List from the Features Menu, and 
type the name of a person (last name first), place, or thing. The NGME will bring you to that point in 
its alphabetical Article Title Index. Double-click a title to read an article. You can scroll through the 
Article Title Index to look at other articles.

Not sure of what article would cover your subject?
You may want to do a Word Search. Click the Word Search button on the Main Toolbar or select Word
Search from the Features Menu, type in a word, and click search. The NGME will prepare a list of 
articles that contain the word you typed. Scroll to and double-click an article title, and the NGME will 
bring you to the part of the article where your subject first appears.

Maybe you're not exactly sure what you're interested in researching.
You may want to use the Knowledge Tree. Click the Knowledge Tree button on the Main Toolbar or 
select Knowledge Tree on the Features Menu    to see the 6 main "branches" of knowledge in the 
NGME. Double-click to go further and further down a "branch" of knowledge until you see an article of
interest. Double-click an article title to read that article.



How to Find a Sound

Click the Sound Index button on the Main Toolbar or select Sounds on the Features Menu to list the 5 
types of sounds featured in the NGME (animal, bird, and musical-instrument sounds, and excerpts of 
musical works and historical speeches). Double-click one of the types to list individual sounds. 
Double-click a sound title and press play to hear that sound.



How to Find a Picture

The NGME has more than 3,000 pictures, indexed by subject. Click the Picture Index button on the 
Main Toolbar or select Pictures on the Features Menu    to see the graphical index of pictures. Select 
a category from the graphical index to see the sub-categories in it. Continue double-clicking index 
entries until you see the titles of individual pictures. Double-click a picture title to see it; click the 
caption button to read the picture's caption.



How to Find an Animation

Click the Animation Index button on the Main Toolbar or select Animations on the Features Menu    to 
view a graphical index of animations featured in the NGME. Select a category to list individual 
animations. Double-click an animation title and press play to see that animation.



How to Find a Video

Click the Video Index button on the Main Toolbar or select Videos on the Features Menu    to list the 
types of videos featured in the NGME. Double-click a category to list individual videos. Double-click a 
video title and press play to see it.



Register the NGME and get Technical Support

There are two ways to register the NGME:

If you have a Grolier Warranty Card, simply fill it out and mail it in. 

If you don't have a Grolier Warranty Card, or if you prefer, simply call (800) 285-4534 to register.

Registering will enable us to provide you with better service and will ensure that you are notified about
specially priced updates.

For technical support, call (408) 428-6600.



How to Play a Multimedia Map

Click the Multimedia Map button on the Main Toolbar or select Multimedia Maps on the Features 
Menu    to see the categories of Multimedia Maps    in the NGME. Select a category from the graphical
index to list the maps in that category. Double-click a map title to open it. Press play to play it.



 Multimedia Map Index (Search menu)

The Multimedia Maps in the NGME illustrate historical events. The Multimedia Map Index groups 
these maps into six categories.

Viewing Multimedia Maps using the Multimedia Map Index

After selecting Multimedia Maps (either by clicking the Multimedia Map button on the Main Toolbar, or 
by pulling down the Search menu and choosing Multimedia Maps), you will see a graphical index of 
the categories of Multimedia Maps. Once you have opened a category, you can select a map by 
double-clicking its title. You can look at the articles related to the map by clicking the cross-reference 
button    on the Multimedia Map toolbar.

Shortcut:  on the Main Toolbar 



How to Play the Knowledge Explorer

Click the Knowledge Explorer button on the Main Toolbar    or select Knowledge Explorer on the 
Features Menu    to see the categories of Knowledge Explorer Essays    in the NGME. Select a 
category from the graphical index to list the essays in it. Double-click an essay to open it. Press play 
to play it.



Knowledge Explorer (Search menu)

The Knowledge Explorer is a collection of audiovisual essays. These essays have been indexed by 
subject. 

Playing Knowledge Explorer Essays using the Knowledge Explorer Index

After selecting Knowledge Explorer (either by clicking the Knowledge Explorer button on the Main 
Toolbar, or by pulling down the Search menu and choosing Knowledge Explorer), you will see a 
graphical index of the categories of Knowledge Explorer essays. Select a category to see the 
Knowlege Explorer essays in it. Double-click an essay title to open it. Press play to begin playing it.

You can view articles associated with a Knowledge Explorer Essay by clicking the cross-reference 
button    on the Knowledge Explorer window toolbar.

Shortcut:  on the Main Toolbar 



How to Use the Timeline

Click the Timeline button    on the Main Toolbar    or select Timeline on the Features Menu    to open 
the Timeline. It will open to the year 40,000 BC. To search the Timeline, type the year you're 
interested in and the NGME will bring you to that year. 



How to Use the Features Menu

The Features Menu allows you to access the main features of the NGME. It opens when you close 
the opening animation. Click a feature on the right side of the menu to select it. Once you have 
selected a feature the Features Menu will disappear. It will only reappear when all of the windows 
within the NGME are closed. All of the features on the Features Menu can also be accessed through 
the toolbar or pull-down menus within the NGME. 



Contributors

Many articles in the NGME are written by experts in their fields. These are called "signed" articles 
because their authors' names are listed at the end of their text. The Contributor list provides an 
alphabetical list of these authors and their affiliations.



Timeline Find button

    If Timeline Find is available from an article or caption, this button will appear in the article/caption's
menu bar.



Picture Player

The Picture Player lets you browse the pictures in the NGME, either randomly or sequentially. 

To begin the Picture Player, select a category from the graphical Picture Index. Two play buttons (forward 
and backward) and a Picture Player Preferences button will appear on the Picture Index menu bar. You 
may launch the Picture Player by clicking either of the play buttons, or you may continue to navigate 
through sub-categories until you've reached an area of interest and then begin the Picture Player.

Click the Picture Player Preferences button to select either the random or sequential playing of pictures. 
You may also set the speed at which the Picture Player plays by selecting a number from 1 to 10 (1 plays 
most slowly, 10 plays most quickly).

You may pause the Picture Player at any time by clicking the pause button. Once the Picture Player is 
paused, you may view a picture's caption, hear a related sound (if available), or see articles related to that
picture by selecting the caption, sound, or articles button from the picture's menu bar. To restart the 
Picture Player, simply select the play button from the picture's menu bar. 


